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Chapter 1: Introduction
HP Virtualization Performance Viewer (HP vPV) is a web-based analysis and visualization tool that
analyzes performance trends of elements in virtualized environments. It enables virtualization
monitoring by providing an overview of the environment, near-real-time and historical data analysis
and triaging using an interactive dashboard. It also enables monitoring for cloud and hypervisor
environments. HP vPV helps you visualize performance data for elements in the context of each
other to rapidly analyze bottlenecks. HP vPV provides performancemonitoring, graphing, and
reporting in a single interface.

Key features of HP vPV are as follows:

l Monitor the health and performance of the virtualized environment from Dashboard view.

l Triage analysis with theWorkbench and capability to trend server utilization across days,
weeks, and amonth.

l Proactivemonitoring of the entities that may cause disruptions in the environment. Use
Treemap to identify and view the problems at a glance.

l Analyze the capacity, usage, and allocation trends for various resources in a virtualized
environment.

l Right sizing recommendation based on historical resource utilization and reclaiming unused
resources.

l Analyze the impact of increasing the workload.

l Determine the impact of adding or deleting resources in your environment.

l Estimate the future capacity utilization in order to proactively plan your hardware requirements.

Conventions Used in this Document
The following conventions are used in this document when referring to the location of files on the
HP Virtualization Performance Viewer (HP vPV) system:

Convention Description Value

<install_dir> The directory where HP vPV is installed. On Linux systems, the
installation directory is
/opt/OV.

<data_dir> The common data directory where data files and
log files related to HP Software products are
stored.

The data directory is
/var/opt/OV.
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Chapter 2: Installation Requirements
During installation, the installer performs the following tasks:

l Checks if your systemmeets the disk space requirements. For information on the disk space,
see "Hardware Requirements".

l Checks if your system has any other HP software product installed. For example: HP vPV co-
exists with HP Operations Agent version 11.13.

l Provides a detailed log of the system disk space and other HP software products detected.

l Provides a list of components installed.

Note: HP vPV supports only x64-bit version of the Linux operating system.

Hardware Requirements
Theminimum hardware requirements for installing HP vPV are:

Item Value

CPU 2 vCPU

Memory 4GB

Disk 40GB

/opt/ 700MB

/var/ 24 GB

Installing on a slower system or one with less memory may result in slow performance.

The following table lists the hardware requirements for using HP vPV with the Premium and
Express licenses:

License vCPU RAM Disk Space
Instances
Monitored

Express 2 4GB 40GB 2000*

Premium 2 4GB 40GB 1000

*HP vPV canmonitor more than 2000 instances by increasing the RAM andCPU. For more
information, see theHP Virtualization Performance Viewer Sizing Guide.
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Supported Browsers
The following table lists the web browsers that are required to access HP vPV:

Operating Systems Supported Browsers

Microsoft Windows Firefox 24 (ESR)

Internet Explorer 10

Internet Explorer 9 (limited support)

Google Chrome (latest version)

Linux Firefox 24 (ESR)

To view the HP vPV home page, install Adobe® Flash Player 10.2 or above and enable JavaScript
support for the Internet Explorer (IE) or Mozilla Firefox browser by adding HP vPV to your list of
Trusted Sites.

Support Matrix

The following table lists the support matrix for HP vPV:

Deliverable Platforms/Versions

Linux Installer RHEL 6.2, 6.3, 6.4

CentOS 6.2, 6.4

Virtual appliance CentOS 6.5

Installation Guide
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Chapter 3: Installing HP vPV
The following section details the different methods to install HP vPV:

l "Deploy the HP vPV Virtual Appliance"

l "Install HP vPV on Linux Nodes"

Note:HP vPV does not support upgrade from the previous versions to version 2.00.

Pre-requisites
Following are the prerequisites for installing HP vPV:

l Ensure that port 8081 is open tomake HP vPV accessible from the remote browser, if there is a
firewall on the system where HP vPV is installed.

l Ensure that port 8444 is open to access in Hypertext Transfer Protocol Secure (HTTPS)mode.

l Ensure that the port used for accessing HP vPV (8081, by default) is open in the firewall, if there
is a firewall between HP vPV andMicrosoft System Center Virtual MachineManager (SCVMM)
server.

l Ensure that the port 5480 is open to access the Virtual ApplianceManagement Interface (VAMI).

Deploy the HP vPV Virtual Appliance
HP vPV is available as a Virtual Appliance for easy deployment in vCenter. You can use the
VMware vSphere Client user interface to deploy the virtual appliance.

The supported VMware vCenter Server versions are 5.0, 5.1, and 5.5.

To deploy the HP vPV virtual appliance, follow these steps:

1. Open VMware vSphere Client.

2. Type the credentials and click Login.

3. Select File > Deploy OVF Template. TheDeploy OVF Templatewindow opens.

4. Click Browse to browse to the location where you have saved the HP vPV virtual appliance
file.

5. Click Next. The window shows the details of virtual appliance.

6. Click Next. The End User License Agreement details appear.
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7. Click Accept and then click Next.

8. Type a name for the virtual appliance in theName field.

9. Select where to deploy the virtual appliance from the Inventory Location tree. Click Next.

10. Select the host or cluster where you want the virtual appliance to run. Click Next.

11. Select the specific host where to run the virtual appliance. Click Next.

12. Select the storage location where you want to store the virtual machine files. Click Next.

13. Select the disk format in which you want to store the virtual disks. Click Next.

14. Type the required Networking Properties and click Next. The window shows the details of the
deployment.

15. Select thePower on after deployment check box.

16. Click Finish. The deployment task starts. After deployment, the virtual appliance name
appears in the tree in the VMware vSphere Client user interface.

Note: Formore information, see the VMware documentation. The steps are subject to change
based on VMware.

Logging in to the Virtual Appliance

You can log in to the HP vPV Virtual Appliance using the username as root. The default password
is vperf*viewer and it is recommended to change the password after logging in.

Install HP vPV on Linux Nodes
Pre-requisites for Linux-Based Installer

Following are the prerequisites for the Installer version of HP vPV:

l Install Libvirt and all its dependencies on the HP vPV server.

Libvirt is an open sourcemanagement tool to manage virtualized platforms such as Linux, KVM,
Xen, and so on.

Libvirt can be installed on following versions of the different Linux distributions:

Installation Guide
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Linux Types OS Versions

CentOS 6.2
6.3
6.4 (64-bit)

RHEL 6.2
6.3
6.4 (64-bit)

l Install Expect and all its dependencies on the HP vPV server.

Expect is a tool that communicates with interactive programs such as ssh.

l For HP vPV standalone installation, install latest unixODBC package, if it is not already
available.

The unixODBC Driver Manager is an open source ODBC driver manager for providing
application developers predictable APIs to access Data Sources.

l To install HP vPV, the following runtime libraries and packages are required:

n On x64 systems:

o glibc-2.3.4-2.36.i686.rpm

o libgcc-3.4.6-8.i386.rpm

o libstdc++-3.4.6-8.i386

o unixODBC-2.2.14-12.el6_3.x86_64.rpm

n To check the packages, use the following command:

rpm -qa | grep -i <packagename>

In this instance, <packagename> is the name of the package to be checked for.

n C++ runtime:

o For systems with kernel version 2.6:

/usr/lib/libstdc++.so.5

o For systems with kernel version 2.6 on Itanium :

/usr/lib/libstdc++.so.6

n Curses runtime library:

Installation Guide
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/usr/lib/libncurses.so.5

n unixODBC runtime library:

/usr/lib64/libodbc.so

n Make sure that them4 utility is installed at the path /usr/bin/m4.

n Set the executable (x) bit for the libvirt library at one of the following paths as appropriate for
your environment:

o /usr/lib64/libvirt.so

o /usr/lib64/libvirt.so.0

o /usr/lib/libvirt.so

o /usr/lib/libvirt.so.0

Note: HP vPV uses HP Vertica during installation. HP Vertica does not support Logical
VolumeManager (LVM) disk.

Pre-requisites:

l Swap sizemust be 2.00 GB.

l Enable SELinux in permissivemode.

To install HP vPV using HP Vertica on a LVM disk, follow these steps:

1. Create a virtual disk.

2. Format the filesystem to ext4.

3. Mount the virtual disk to /var/opt/OV.

4. Open the /etc/fstab file.

Add the following entry:

</dev/sdb1> /var/opt/OV ext4 defaults 0 0

where </dev/sdb1> is the virtual disk that you have created.

5. Run mount command to check if /var/opt/OV is mounted.

6. Install HP vPV version 2.00. For more information on Installing HP vPV, see "Attended
Installation" on the next page or "Unattended Installation" on page 15.

You can install HP vPV by using any of the following procedures:

Installation Guide
Chapter 3: Installing HP vPV

HP Virtualization Performance Viewer (2.00) Page 12 of 43



l "Attended Installation"

l "Unattended Installation"

Note: To install HP vPV on your system, youmust log on as root user.

Attended Installation
To install HP vPV throughGraphical and command line interface, follow these steps:

Installing HP vPV through Graphical Interface

To install HP vPV using X11 interface, perform the following tasks:

1. Login as a root user.

2. Place the HP vPV CD/DVD-ROMmedia in the CD/DVD drive. If necessary, mount the
CD/DVD-ROM.

3. To start installation, if you want to use the X11 terminal window, export the DISPLAY variable
to point to an X11 terminal type the following command:

export DISPLAY=<IP_Address/system_name>:0.0

where, <IP_Address/system_name> is the IP address or the system name of the X11
terminal.

4. Type the following:

<CD/DVD-ROM> HPPV_1.xx.xxx_setup.bin

where, <CD/DVD-ROM> is the drive letter of the CD/DVD ROM.

The HP vPV Installation wizard appears. This window displays an introductory message.

Note: If you are installing HP vPV for the first-time on your Linux system, the
ovinstallparams.ini file containing the installation parameters is created in the
system’s temporary directory. During installation, HP Installer checks for the
ovinstallparams.ini file. If HP Installer detects the ovinstallparams.ini file on your
system, amessage asking if you want to reuse the values in the file appears.

n Click Yes to use the values in the configuration file as default values.

n Click No to overwrite the existing configuration file.

Installation Guide
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If HP Installer does not find the file, the system creates the ovinstallparams.ini file
with default values in the temporary directory. To save the ovinstallparams.ini data,
copy the file to an alternate location, before installing other HP products.

5. On the HP vPV Installation wizard, click Next. The License Agreement screen appears.

6. Read the terms of license agreement. To continue with installation, select I accept the terms
of License Agreement option. The installation wizard performs install checks.

7. Click Next. The Pre-Install Summary screen appears. The screen displays the list of
components that will be installed.

8. Click Install.

Note: If the installation fails, you can roll back or quit installation. TheRoll Back option
removes the components which are already installed.

ClickingQuit stops the installation, but does not uninstall the components installed till
then.

When you start HP vPV installation next time, the Installer prompts you to confirm if you
want to resume the installation or uninstall HP vPV.

9. Click Details tab and expand the components tree to view the list of components.

10. To view the log file on your system, click View Log Files.

11. Click Done to complete the installation.

Note: If the system needs to be restarted, the followingmessage appears after installation
is complete: ‘Youmay need to restart your system for the configuration changes made to
the system to take effect. Would you like to quit this installation?’.

It is recommended that you restart your system after installation.

Installing HP vPV through Command Line Interface

Note: Localization is not supported when installing HP vPV in consolemode. As a result,
some text may be illegible.

To install HP vPV through Command Line interface, follow these steps:

Installation Guide
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1. Login as a root user.

2. Insert the HP vPV CD/DVD-ROMmedia into the CD/DVD drive. If necessary, mount the
CD/DVD-ROM.

3. Run the following command:

If you are installing HP vPV on a stand-alone system:

<CD/DVDROM_mount>/HPPV_1.xx.xxx_setup.bin -i console

where, <CD/DVD-ROM> is the drive letter of the CD/DVD ROM.

If you have configured the locale of the system to one of the following languages: English,
Japanese, and Simplified Chinese, the installer prompts you to select the language at the
beginning of the installation. You will have the option of choosing the language to which your
system locale is set. If the system locale is set to any other language apart from these, the
installer displays only ‘English’.

4. When the prompt, I accept the terms of the License Agreement for the License information
appears, typeY to accept the terms and continue installation. The installer checks all the
Install Requirements.

5. Click Enter to continue. The pre-installation summary appears.

6. Click Enter to continue.

When the installation is complete, you will receive amessage which states that the installation
was completed successfully.

Unattended Installation
To carry out unattended installation, follow these steps:

1. Login as a root user.

2. Insert the HP vPV CD/DVD-ROMmedia into the CD/DVD drive. If necessary, mount the
CD/DVD-ROM.

3. Go to the directory where the CD/DVD-ROM is mounted.

4. Type the following syntax at the command prompt:

./HPPV_1.xx.xxx_setup.bin -i silent

Note: If the installer finds a working installation of HP vPV, it will uninstall HP vPV when

Installation Guide
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you run the -i silent command. If not, it will install HP vPV.

5. To verify the installation, check the log files.

Verify the Installation
On successful installation:

l The Linux systems display the application directory and data directory paths.

l To view install log files see the following:

For Linux: /tmp/HPPV_1.xx.xxx_HPPVInstaller.txt

/var/tmp/HPPVInstaller/PerfUtil-mm-dd-yyyy.log.0

In this instance, mm indicates themonth, dd indicates the day, and yyyy indicates the year. The
file name indicates the time stampwhen the install was performed.

Installation Guide
Chapter 3: Installing HP vPV

HP Virtualization Performance Viewer (2.00) Page 16 of 43



Chapter 4: Getting Started
After installing HP vPV, you can start using the product by accessing the user interface. To launch
HP vPV, you can use the following URL:

http://<system>:<port>/PV OR https://<system>:<port>/PV.

If authentication is enabled, log in using the user name and password. The Admin page opens for
the first time.

To start using the product, add the data sources to bemonitored. For more information on adding
data sources, see theHP Virtualization Performance Viewer Online Help.

Installation Guide
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Chapter 5: Configuring HP vPV
The following section details different methods to configure HP vPV:

l Configure Secure Communication with Tomcat Server

l Add a vCenter server running on a non-default port

Configure Secure Communication with Tomcat
Server

The HTTP and HTTPS protocols are by default enabled for HP vPV. The default port numbers for
HTTP and HTTPS are 8081 and 8444 respectively. You can choose to use either of the protocols.
However, to ensure security for administration-related tasks, youmust access HP vPV in the
secure communications mode. To access HP vPV in the securemode, use the following URL:

https://<systemname>:8444/PV

To access HP vPV in the non securemode, use the following URL:

http://<systemname>:8081/PV

You can also change the default port settings for both HTTP and HTTPS communications.

Changing Port Settings

The default HTTP port number to access HP vPV is 8081 and the default port number for secure
connection is 8444. All client systems are authorized to connect to HP vPV server. To change the
default port number for the HP vPV server, follow these steps:

1. Check for the availability of the port number you want to use, by running the following
commands at the command prompt:

cd <bin_dir>

ovtomcatbctl -checkport <portnumber>

A message indicating if the port is available or in use appears. For example, if you are checking
for the availability of the port number 8081, themessage, “Port Number 8081 is not in use”
appears, if the port number is available. If the Port Number 8081 is not available, a message
indicating that the port number is used by another program or service appears.

2. Stop HP vPV by running the following command at the command prompt:

pv stop

3. To change http or https port numbers for HP vPV server, run the following command at the
command prompt:
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cd <bin_dir>

ovconfchg -ns NONOV.TomcatB -Set HTTPPort <port number>

ovconfchg -ns NONOV.TomcatB -Set HTTPSPort <port number>

4. Start the HP vPV server.

Disabling Secure Communications

To disable secure communications, perform the following steps:

1. Stop HP vPV, if HP vPV is running.

2. Run the following command at the command prompt:

cd <bin_dir>

ovconfchg -ns NONOV.TomcatB -set EnableHTTPS False

Note: To enable secure communication again, set the value to True, instead of False, in
the preceding command.

3. Restart HP vPV.

Using SSL or HTTPS with the Tomcat Web Server

To use SSL or HTTPS protocols with the Tomcat web server, you need to obtain a server certificate
for Tomcat after installing HP vPV. You can replace the certificate obtained after HP vPV
installation in the following scenarios:

l When you connect to HP vPV using HTTPS protocol, the certificate and name of the system are
compared to ensure that the names match. If the names are not similar, most browsers alert the
users so that they can decide to either continue or cancel the connection. If the name used by
HTTPS users is different from the name used by the HP vPV installation, youmust obtain a
different certificate.

l Youmay need to obtain a new certificate when you want to fill the fields in the certificate that are
left blank during HP vPV installation. The certificate contains many fields to provide information,
such as, the issuer of the certificate and other fields that warrant the safety provided by the
certificate. The HP vPV installation certificate leaves most of these fields blank.

l When you want to change the default certificate password to avoid unauthorized changes, you
must replace the existing certificate.

To replace the Tomcat SSL certificate, perform the following steps:

Installation Guide
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1. Delete the existing certificate by running the following command at the command prompt.

keytool -delete -alias ovtomcatb -keystore /var/opt/OV/certificates/tomcat/b/tomcat.keystore

The keytool path on Linux is /opt/OV/nonOV/jre/b/bin

2. Restart HP vPV.

3. Create a new certificate. To create a new certificate, run Keytool by entering the following
commands at the command prompt:

keytool -genkey -alias ovtomcatb -keyalg RSA -keystore
/var/opt/OV/certificates/tomcat/b/tomcat.keystore

4. Restart HP vPV.

Add a vCenter server running on a non-default port
vCenter Server system requires port 443, for connections from the vSphere and Software
Development Kit (SDK) clients. By default, vCenter collector of HP vPV 2.0 uses port 443 for data
collection from vCenter server. If this default port 443 is re-configured in your environment due to
any reason, it is recommended to use the iptables to route the traffic.

During the HP vPV 2.0 installation, run the iptables command and setup port forwarding rules for
each of the target.

Follow the steps:

1. Log on as a root user.

2. Run the following command:

iptables -t nat -A OUTPUT -p tcp -m tcp -d <target vcenter(s) ip> --dport 443
-j DNAT --to-destination <target vcenter(s) ip>:<target port>

In this instance, <target vcenter(s) ip> is the ip address of the target vCenter and <target
port> is the port number of the target.

Using HP vPV Commands
After you install HP vPV, you can use the following commands to administer the HP vPV
workspace through the command prompt.

<bin_dir>/pv <Options>

You can replace <Options> with any of the following variables:

l status - To check the HP vPV status.

l start - To start HP vPV.

Installation Guide
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All the applications that useOvTomcatB are started when you run pv start command.

l stop - To stop HP vPV.

All the applications that useOvTomcatB are stopped when you run pv stop command.

l restart - To stop and then start HP vPV.

l trace on - To start generating detailed trace files.

l trace off - To stop generating detailed trace files.

l version - To display the version of HP vPV installed on your system.

Installation Guide
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Chapter 6: License Management
After you install HP vPV, you can purchase the appropriate licenses based on your business
requirements. These licenses enable you to access all the features of the product. To purchase the
respective license, click You have Evaluation/Community license. Click to buy license link.
The link navigates to theBuy License page. Enter your details in theContact Me tab and click
Submit. Make sure email client is configured in your browser.

To access the License tab on the HP vPV user interface:

1. Log in to the HP vPV user interface to import licenses.

2. Select Admin from the HP vPV home page.

The LicenseManagement tab provides information about your HP vPV licenses. You can also use
this tab to start using your Evaluation License as well as import a HP vPV license. For more
information on importing licenses, see "Importing Licenses".

Note: If you install an Express license on the HP vPV server which uses a Community
license, then the Community license expires.

If you want to retain the Community license, create a separate HP vPV server to install the
Express license.

For more information on the difference between the licenses and the features available, see "Types
of Licenses"

User Interface
The following table lists the sections available in the LicenseManagement tab.

Section Description

License Status Displays information regarding the installed licenses. The two tables available
are:

l Active License Features

l Installed Licenses

Manage
License

To import permanent licenses.

TheActive License Details table lists the following information about your current HP vPV
License:

l Capacity or number of instances available corresponding to each license.

l Number of instances that can bemonitored, based on the installed license
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l Data Retention

The Installed Licenses table lists the following information regarding the active and all installed
licenses for HP vPV:

l Type of license installed

l Date of license expiry

Types of Licenses
The following table lists the available features for the Community, Express, Premium, and
Evaluation HP vPV Licenses:

Feature
Community
License

Express
License

Premium
License

Evaluation
License

Number of Instances 25 instances 6000
Tested up to 6000 instance. Larger
configurations can be supported. For more
information, see theHPvPVSizingGuide.

Data Retention Up to 24
hours

90 days 90 days 60 days

Enterprise Directory Integration No Yes Yes Yes

Reports Yes Yes Yes Yes

HP OM, HP PM andHP BSM
Integration

No Yes Yes Yes

HP CSA Integration No No Yes Yes

Guest Operating System drill
down for advanced
troubleshooting

No No Yes Yes

Current Capacity Reports (Only
for VMware™ vSphere and
Microsoft™HyperV)

No No Yes Yes

Best-fit Capacity Optimization
(Only for VMware™ vSphere and
Microsoft™HyperV)

No No Yes Yes

Virtual Machine Placement (Only
for VMware™ vSphere )

No No Yes Yes

Capacity Demand Forecast
(Only for VMware™ vSphere and
Microsoft™HyperV)

No No Yes Yes
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Feature
Community
License

Express
License

Premium
License

Evaluation
License

Alerting (Only for VMware™
vSphere )

No Yes Yes Yes

Capacity Modeler (Only for
VMware™ vSphere )

No No Yes Yes

Dashboard No No Yes Yes

Note: The number of instances denote only the VMs and hosts.

All product features are available for the Evaluation License. The only difference between the
Evaluation License and Premium License is the validity.

Evaluation License
After installing HP vPV, by default, your active license will be Community License. To start using
your Evaluation License, click Start Evaluation. The page refreshes and displays information
regarding your Evaluation License.

After the Evaluation License expires (after 60 days), the system changes your license
automatically to Community License.

Note:Data collection works only when the sum of instances from all data sources is less than
or equal to themaximum instance capacity of the license. If the total instance count exceeds
themaximum instance capacity of the license, then connection for all the data sources fails.
For example, if you install a Premium license for 100 instances, and try to connect two hosts
with 60 instances each, then the collection fails for both the hosts.

License Validity

The following table lists the validity of the different HP vPV licenses:

License Validity

Community Not Applicable

Evaluation 60 days

Premium Depends on the date when license is ordered

Express Depends on the date when license is ordered

Importing Licenses
After you purchase a license, youmust import it before you start using HP vPV.

To import licenses for HP vPV, follow these steps:
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1. Go to the License Management tab in Admin page.

2. Type your license key in the License Key field of theManage License section.

3. Click Import License. The License Status section refreshes to display the details of the
license imported.

To clear the license key typed in, click Reset.
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Chapter 7: Removing HP vPV
You can remove HP vPV installed on Linux systems by using the procedure described in the
following section:

HP vPV Virtual Appliance
To remove the HP vPV virtual appliance, power off the VM and delete the VM.

Remove HP vPV from Linux Nodes
To remove HP vPV from a Linux system:

1. Log on as root user.

2. Go to /opt/OV/Uninstall/HPPV.

3. Run the uninstall command:

n To use an X11 interface, export the DISPLAY variable to point to an X11 terminal if
necessary. Then run the command:

./setup.bin

n To use a command line interface, run the command:

./setup.bin -i console

4. Select Uninstall.

Removing Configurations and User Graph Templates
Removing HP vPV does not remove configurations or user graph templates. You need tomanually
remove the files from the data directory.

Removing HP vPV Files using the Clean-up Script
After removing HP vPV, youmust run the following clean-up script. This script is available in the
<install_dir>\support:

l clnup_pv.sh for Linux

The clean-up script removes the following files from <data_dir>\conf\perf:
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l OVPMconfig.ini

l OVPMUsers.xml

l OVPMSystems.xml

l ovpm.tcf

l VPI_GraphsUserFavorites.txt

l OVPMReportTemplate.htm

l All folders starting with the name "VPI_".

l All PV database related files

Note: If you plan to reinstall HP vPV on the same system, make sure you delete the following
folders after you finish running the clean-up script:

l /opt/OV/

l /opt/vertica/

l /var/opt/OV/
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Chapter 8: Troubleshooting HP vPV
The following section details how to troubleshoot HP vPV:

Vertica database is filled to near capacity due to the increase in the log file size.

Symptom The Vertica database is filled to near capacity due to the increase in the log file size.

Causes Vertica database consolidates and retains the log data in a .gz file daily. By default,
this process (called ‘rotate’) continues for 52 weeks.

Resolution To createmore space on the Vertica database implement any one of the two
solutions below:

Solution 1

1. Go to /opt/vertica/config/logrotate/.

2. Open the pv file.

3. In the pv file, under # and keep for 52 weeks change the value of rotate from
52 to the number of weeks for which you want to save the rotated log files.

For example: rotate 3

In this instance, the Vertica database will retain the .gz files for 3 weeks.

4. Repeat step 3 for all instances of # and keep for 52 weeks.

5. Save and close the file.

Solution 2

1. Login as a root user.

2. Run the following commands on the HP vPV server:

cd /opt/vertica/bin

./admintools -t logrotate -d pv -r weekly -k <number_of_weeks>

where, <number_of_weeks> is the number of weeks for which you want to
retain the rotated logs.

Unable to Access HP vPV

Symptom Unable to access HP vPV through the default network port settings.
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Causes l Your system has ovTomcatB configured to run with the non-root user or non-
local system account privileges and you have HP vPV installed on such a
system.

l You cannot access HP vPV using the default http (8081) or https (8444) ports if
these ports are in use by other applications.

Resolution l Check if ovTomcatB is configured to run with the non-root user or non-local
system account privileges. If so, modify the settings to run ovTomcatB with the
Administrator or root user privileges.

l Try accessing HP vPV by using the following URL:

http://<IP address/system name>:<port number>/PV

where, <IP address/system name> is the IP address or the system name of the
HP vPV server and <port number> is the port number of the HP vPV server.

If the HP vPV Home page does not appear, check if the default ports are in use.

l To change the port settings, follow these steps:

1. Run the following command at the command prompt to change the port
numbers for HTTP, HTTPS, and ShutdownPorts:
<bin_dir>ovconfchg -ns NONOV.TomcatB -set HTTPPort <port number>

<bin_dir>ovconfchg -ns NONOV.TomcatB -set HTTPSPort <port number>

<bin_dir>ovconfchg -ns NONOV.TomcatB -set ShutdownPort <port number>

2. Restart HP vPV.

Unable to connect to HP vPV server through HTTPS protocol

Symptom HP vPV is unable to connect to the server through secure communication (HTTPS)
protocol.

Cause The connection times out when HP vPV is not able to connect through the secure
client in the default timeout interval of one second.

Resolution Use the parameterSECURE_CLIENT_CONNECT_TIMEOUT to adjust the
timeout interval to connect to HP vPV server depending on your Internet
connectivity or infrastructure setup.

Deployment of HP vPV fails

Symptom The deployment of the HP vPV Virtual Appliance fails.

Cause This may happen when the time on the ESX server is set to a future time.

Resolution Ensure that the time on the ESX server is set correctly.
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Unable to view content on HP vPV home page

Symptom TheHP vPV Home page does not display anything except the header.

Cause JavaScript is not supported or Adobe® Flash Player is not installed in your browser.
Adobe® Flash Player version 10.3 is theminimum required version.

Resolution Install Adobe® Flash Player and enable JavaScript support for the Internet Explorer
(IE) or Mozilla Firefox browser by adding HP vPV to your list of Trusted Sites.

l To add HP vPVWeb server URL to a trusted site, perform the following steps:

For IE browser

a. From the Tools menu, click Internet Options. The Internet Options pop-up
window appears.

b. Click Security tab.

c. Select the Trusted Sites icon.

d. Click Sites. The Trusted Sites pop-up window appears.

e. Type the HP vPV web server URL and click Add. The typed URL appears in
the list of trusted sites.

f. Click Close.

g. Click OK.

h. Restart the browser.

For Mozilla Firefox browser

a. From theEditmenu, click Preferences. TheOptions pop-up window appears.

b. Click Privacy tab.

c. Click Exceptions.

d. Type the HP vPV web server URL in the box under Address of web site.

e. Click Allow.

f. Click Close.

g. Click OK.

h. Restart the browser.
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Resolution l If Adobe® Flash Player is not installed in your browser, HP vPV Home page
does not appear. The browser displays amessage stating that youmust Install
Adobe Flash Player to view the HP vPV HomePage. Click themessage to
download Adobe® Flash Player.

l If JavaScript is not enabled in your browser, HP vPV Home page does not
appear in the IE browser even after adding it as a trusted site. The browser
displays amessage stating that JavaScript is not enabled in your browser and
youmust enable JavaScript to view the page.

To enable JavaScript support, perform the following steps:

For IE browser

a. From the Tools menu, click Internet Options. The Internet Options pop-up
window appears.

b. Click theSecurity tab. Check if the security level in your browser settings is
set to High.

c. Make sure the Trusted Sites icon is selected and click Custom Level. The
Security Settings pop-up window appears.

d. Scroll down to Scripting section and select theEnabled option underActive
Scripting.

e. Click OK.

f. Click Apply.

For Mozilla Firefox browser:

a. From the Tools menu, click Options.

b. Click Content.

c. Select theEnable JavaScript check box.

d. Click OK.

HTTP Status 404 - /PV Error

Symptom When trying to access HP vPV, you get the HTTP Status 404 - /PV Error message.

Cause Themessage appears if the <INSTALLDIR>/www/webapps/PV directory is empty.

Resolution Extract the Perf.war file again from <Install_Dir>/newconfig/PV to <Install_
dir>/www/webapps/PV. Run the command pv deploywar.

What are the log files available with HP vPV?
The following table lists the log files available with HP vPV:
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Component Description Location

pvcd (PV
Collection
Daemon)

pvcd daemon uses XPL tracing
mechanism. A default pvcdXPL.itc (trace
configuration) is available in
/opt/OV/support directory.

To start the tracing, run
/opt/OV/support/ovtrccfg -app
pvcd -cf
/opt/OV/newconfig/conf/xpl/trc
/pvcdXPL.itc The XPL trace files are
present at /tmp/pvcd_*.trc.

To stop tracing, run
/opt/OV/support/ovtrccfg -app
pvcd -off

If tracing is enabled, /tmp/
directory contains the trace files
(use - ls /tmp/pvcd_
*.trc)

pvcd and pvconfig tools log important
status and error messages, if any, in
System.txt.

/var/opt/OV/log/System.txt

Collectors vCenter andOpenStack collector status
log file
/var/opt/OV/log/status.virtserver

/var/opt/OV/log/status.virt
server

KVM collector status log file /var/opt/OV/log/status.kvm

XEN collector status log file /var/opt/OV/log/tmp/status.
xen

Database
Transaction

Vertica catalog file to view database
transactions

/var/opt/OV/databases/pv/ca
talog/pv/v_pv_node0001_
catalog/vertica.log

User Interface Local trace and logmessages are logged in
ovpmtrace.0.txt and ovpm.0.log

/var/opt/OV/log
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Appendix: RPMs Packaged with the HP vPV
Virtual Appliance

The RPMs packaged with the HP vPV Virtual Appliance are as follows:

l setup-2.8.14-20.el6.noarch

l basesystem-10.0-4.el6.noarch

l tzdata-2012j-1.el6.noarch

l glibc-common-2.12-1.107.el6.x86_64

l ncurses-libs-5.7-3.20090208.el6.x86_64

l libattr-2.4.44-7.el6.x86_64

l zlib-1.2.3-29.el6.x86_64

l audit-libs-2.2-2.el6.x86_64

l popt-1.13-7.el6.x86_64

l db4-4.7.25-17.el6.x86_64

l nspr-4.9.2-1.el6.x86_64

l bzip2-libs-1.0.5-7.el6_0.x86_64

l libselinux-2.0.94-5.3.el6.x86_64

l sed-4.2.1-10.el6.x86_64

l glib2-2.22.5-7.el6.x86_64

l gawk-3.1.7-10.el6.x86_64

l sqlite-3.6.20-1.el6.x86_64

l libxml2-2.7.6-8.el6_3.4.x86_64

l libstdc4.4.7-3.el6.x86_64

l dbus-libs-1.2.24-7.el6_3.x86_64

l grep-2.6.3-3.el6.x86_64

l findutils-4.4.2-6.el6.x86_64
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l cyrus-sasl-lib-2.1.23-13.el6_3.1.x86_64

l libblkid-2.17.2-12.9.el6.x86_64

l keyutils-libs-1.4-4.el6.x86_64

l libgssglue-0.1-11.el6.x86_64

l libgpg-error-1.7-4.el6.x86_64

l vim-minimal-7.2.411-1.8.el6.x86_64

l checkpolicy-2.0.22-1.el6.x86_64

l sysvinit-tools-2.87-4.dsf.el6.x86_64

l perl-Pod-Escapes-1.04-129.el6.x86_64

l perl-Module-Pluggable-3.90-129.el6.x86_64

l perl-libs-5.10.1-129.el6.x86_64

l pth-2.0.7-9.3.el6.x86_64

l keyutils-1.4-4.el6.x86_64

l grubby-7.0.15-3.el6.x86_64

l upstart-0.6.5-12.el6.x86_64

l libusb-0.1.12-23.el6.x86_64

l nss-softokn-3.12.9-11.el6.x86_64

l xz-lzma-compat-4.999.9-0.3.beta.20091007git.el6.x86_64

l MAKEDEV-3.24-6.el6.x86_64

l net-tools-1.60-110.el6_2.x86_64

l tar-1.23-11.el6.x86_64

l pinentry-0.7.6-6.el6.x86_64

l e2fsprogs-libs-1.41.12-14.el6.x86_64

l which-2.19-6.el6.x86_64

l diffutils-2.8.1-28.el6.x86_64

l dash-0.5.5.1-4.el6.x86_64
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l groff-1.18.1.4-21.el6.x86_64

l coreutils-libs-8.4-19.el6.x86_64

l cracklib-2.8.16-4.el6.x86_64

l coreutils-8.4-19.el6.x86_64

l module-init-tools-3.9-21.el6.x86_64

l redhat-logos-60.0.14-12.el6.centos.noarch

l libpciaccess-0.13.1-2.el6.x86_64

l rpcbind-0.2.0-11.el6.x86_64

l nss-3.14.0.0-12.el6.x86_64

l nss-tools-3.14.0.0-12.el6.x86_64

l libuser-0.56.13-5.el6.x86_64

l pciutils-libs-3.1.10-2.el6.x86_64

l mingetty-1.08-5.el6.x86_64

l ustr-1.0.4-9.1.el6.x86_64

l libffi-3.0.5-3.2.el6.x86_64

l newt-0.52.11-3.el6.x86_64

l ca-certificates-2010.63-3.el6_1.5.noarch

l python-libs-2.6.6-36.el6.x86_64

l libssh2-1.4.2-1.el6.x86_64

l curl-7.19.7-35.el6.x86_64

l rpm-4.8.0-32.el6.x86_64

l python-pycurl-7.19.0-8.el6.x86_64

l gnupg2-2.0.14-4.el6.x86_64

l pygpgme-0.1-18.20090824bzr68.el6.x86_64

l yum-metadata-parser-1.1.2-16.el6.x86_64

l yum-plugin-fastestmirror-1.1.30-14.el6.noarch
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l bind-libs-9.8.2-0.17.rc1.el6.x86_64

l fipscheck-lib-1.2.0-7.el6.x86_64

l kbd-misc-1.15-11.el6.noarch

l policycoreutils-2.0.83-19.30.el6.x86_64

l iproute-2.6.32-23.el6.x86_64

l util-linux-ng-2.17.2-12.9.el6.x86_64

l udev-147-2.46.el6.x86_64

l plymouth-0.8.3-27.el6.centos.x86_64

l dracut-004-303.el6.noarch

l rsyslog-5.8.10-6.el6.x86_64

l cyrus-sasl-2.1.23-13.el6_3.1.x86_64

l cronie-anacron-1.4.4-7.el6.x86_64

l crontabs-1.10-33.el6.noarch

l nfs-utils-1.2.3-36.el6.x86_64

l selinux-policy-3.7.19-195.el6.noarch

l kernel-firmware-2.6.32-358.el6.noarch

l dhclient-4.1.1-34.P1.el6.centos.x86_64

l system-config-firewall-base-1.2.27-5.el6.noarch

l bfa-firmware-3.0.3.1-1.el6.noarch

l iwl100-firmware-39.31.5.1-1.el6.noarch

l b43-openfwwf-5.2-4.el6.noarch

l aic94xx-firmware-30-2.el6.noarch

l iwl1000-firmware-39.31.5.1-1.el6.noarch

l authconfig-6.1.12-13.el6.x86_64

l gettext-0.17-16.el6.x86_64

l grub-0.97-81.el6.x86_64
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l wget-1.12-1.8.el6.x86_64

l passwd-0.77-4.el6_2.2.x86_64

l audit-2.2-2.el6.x86_64

l acl-2.2.49-6.el6.x86_64

l ql2400-firmware-5.08.00-1.el6.noarch

l ql2100-firmware-1.19.38-3.1.el6.noarch

l libertas-usb8388-firmware-5.110.22.p23-3.1.el6.noarch

l ql2500-firmware-5.08.00-1.el6.noarch

l zd1211-firmware-1.4-4.el6.noarch

l rt61pci-firmware-1.2-7.el6.noarch

l ql2200-firmware-2.02.08-3.1.el6.noarch

l ipw2100-firmware-1.3-11.el6.noarch

l ipw2200-firmware-3.1-4.el6.noarch

l vmware-studio-vami-tools-2.6.0.0-631426.x86_64

l vmware-studio-vami-servicebase-2.6.0.0-631426.x86_64

l vmware-studio-vami-service-system-2.6.0.0-0.x86_64

l vmware-studio-vami-service-oaconfig-1.0.0.0-0.x86_64

l vmware-studio-appliance-config-2.6.0.0-130820235403.noarch

l vmware-studio-vami-login-2.6.0.0-631426.x86_64

l libgcc-4.4.7-3.el6.x86_64

l filesystem-2.4.30-3.el6.x86_64

l ncurses-base-5.7-3.20090208.el6.x86_64

l nss-softokn-freebl-3.12.9-11.el6.x86_64

l glibc-2.12-1.107.el6.x86_64

l bash-4.1.2-14.el6.x86_64

l libcap-2.16-5.5.el6.x86_64
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l info-4.13a-8.el6.x86_64

l libcom_err-1.41.12-14.el6.x86_64

l chkconfig-1.3.49.3-2.el6.x86_64

l libacl-2.2.49-6.el6.x86_64

l nss-util-3.14.0.0-2.el6.x86_64

l libsepol-2.0.41-4.el6.x86_64

l shadow-utils-4.1.4.2-13.el6.x86_64

l gamin-0.1.10-9.el6.x86_64

l readline-6.0-4.el6.x86_64

l xz-libs-4.999.9-0.3.beta.20091007git.el6.x86_64

l libidn-1.18-2.el6.x86_64

l file-libs-5.04-15.el6.x86_64

l tcp_wrappers-libs-7.6-57.el6.x86_64

l pcre-7.8-6.el6.x86_64

l lua-5.1.4-4.1.el6.x86_64

l bzip2-1.0.5-7.el6_0.x86_64

l libuuid-2.17.2-12.9.el6.x86_64

l expat-2.0.1-11.el6_2.x86_64

l krb5-libs-1.10.3-10.el6.x86_64

l elfutils-libelf-0.152-1.el6.x86_64

l libtirpc-0.2.1-5.el6.x86_64

l libselinux-utils-2.0.94-5.3.el6.x86_64

l cpio-2.10-11.el6_3.x86_64

l gdbm-1.8.0-36.el6.x86_64

l perl-version-0.77-129.el6.x86_64

l perl-Pod-Simple-3.13-129.el6.x86_64
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l perl-5.10.1-129.el6.x86_64

l libgcrypt-1.4.5-9.el6_2.2.x86_64

l dbus-glib-0.86-5.el6.x86_64

l libnih-1.0.1-7.el6.x86_64

l gmp-4.3.1-7.el6_2.2.x86_64

l file-5.04-15.el6.x86_64

l xz-4.999.9-0.3.beta.20091007git.el6.x86_64

l libutempter-1.1.5-4.1.el6.x86_64

l procps-3.2.8-25.el6.x86_64

l psmisc-22.6-15.el6_0.1.x86_64

l db4-utils-4.7.25-17.el6.x86_64

l libss-1.41.12-14.el6.x86_64

l m4-1.4.13-5.el6.x86_64

l libgomp-4.4.7-3.el6.x86_64

l binutils-2.20.51.0.2-5.36.el6.x86_64

l ncurses-5.7-3.20090208.el6.x86_64

l less-436-10.el6.x86_64

l gzip-1.3.12-18.el6.x86_64

l cracklib-dicts-2.8.16-4.el6.x86_64

l pam-1.1.1-13.el6.x86_64

l hwdata-0.233-7.9.el6.noarch

l plymouth-scripts-0.8.3-27.el6.centos.x86_64

l cvs-1.11.23-15.el6.x86_64

l logrotate-3.7.8-16.el6.x86_64

l nss-sysinit-3.14.0.0-12.el6.x86_64

l openldap-2.4.23-31.el6.x86_64
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l libcap-ng-0.6.4-3.el6_0.1.x86_64

l ethtool-3.5-1.el6.x86_64

l libevent-1.4.13-4.el6.x86_64

l libsemanage-2.0.43-4.2.el6.x86_64

l slang-2.2.1-1.el6.x86_64

l plymouth-core-libs-0.8.3-27.el6.centos.x86_64

l openssl-1.0.0-27.el6.x86_64

l python-2.6.6-36.el6.x86_64

l libcurl-7.19.7-35.el6.x86_64

l rpm-libs-4.8.0-32.el6.x86_64

l rpm-python-4.8.0-32.el6.x86_64

l python-urlgrabber-3.9.1-8.el6.noarch

l gpgme-1.1.8-3.el6.x86_64

l newt-python-0.52.11-3.el6.x86_64

l python-iniparse-0.3.1-2.1.el6.noarch

l yum-3.2.29-40.el6.centos.noarch

l mysql-libs-5.1.66-2.el6_3.x86_64

l fipscheck-1.2.0-7.el6.x86_64

l centos-release-6-4.el6.centos.10.x86_64

l iptables-1.4.7-9.el6.x86_64

l iputils-20071127-16.el6.x86_64

l initscripts-9.03.38-1.el6.centos.x86_64

l libdrm-2.4.39-1.el6.x86_64

l kbd-1.15-11.el6.x86_64

l dracut-kernel-004-303.el6.noarch

l openssh-5.3p1-84.1.el6.x86_64
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l postfix-2.6.6-2.2.el6_1.x86_64

l cronie-1.4.4-7.el6.x86_64

l nfs-utils-lib-1.1.5-6.el6.x86_64

l iptables-ipv6-1.4.7-9.el6.x86_64

l dhcp-common-4.1.1-34.P1.el6.centos.x86_64

l kernel-2.6.32-358.el6.x86_64

l selinux-policy-targeted-3.7.19-195.el6.noarch

l openssh-server-5.3p1-84.1.el6.x86_64

l iwl5150-firmware-8.24.2.2-1.el6.noarch

l iwl6050-firmware-41.28.5.1-2.el6.noarch

l iwl6000g2a-firmware-17.168.5.3-1.el6.noarch

l iwl6000-firmware-9.221.4.1-1.el6.noarch

l bind-utils-9.8.2-0.17.rc1.el6.x86_64

l man-1.6f-32.el6.x86_64

l libxml2-python-2.7.6-8.el6_3.4.x86_64

l gdb-7.2-60.el6.x86_64

l efibootmgr-0.5.4-10.el6.x86_64

l sudo-1.8.6p3-7.el6.x86_64

l e2fsprogs-1.41.12-14.el6.x86_64

l attr-2.4.44-7.el6.x86_64

l iwl5000-firmware-8.83.5.1_1-1.el6_1.1.noarch

l ivtv-firmware-20080701-20.2.noarch

l xorg-x11-drv-ati-firmware-6.99.99-1.el6.noarch

l atmel-firmware-1.3-7.el6.noarch

l iwl4965-firmware-228.61.2.24-2.1.el6.noarch

l iwl3945-firmware-15.32.2.9-4.el6.noarch
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l rt73usb-firmware-1.8-7.el6.noarch

l ql23xx-firmware-3.03.27-3.1.el6.noarch

l rootfiles-8.1-6.1.el6.noarch

l vmware-studio-init-2.6.0.0-130820235404.noarch

l vmware-studio-vami-cimom-2.6.0.0-631426.x86_64

l vmware-studio-vami-service-core-2.6.0.0-0.x86_64

l vmware-studio-vami-service-network-2.6.0.0-0.x86_64

l vmware-studio-vami-service-update-2.6.0.0-0.x86_64

l vmware-studio-vami-lighttpd-2.6.0.0-631426.x86_64
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on Installation Guide (Virtualization Performance Viewer 2.00)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client,
and send your feedback to docfeedback@hp.com.
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